Case Study of the Banana SPS Gene Family
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In this document, we provide an overview of the functionalities of the Banana Genome Hub. For this purpose we selected a specific gene family to support
the description. We studied the Sucrose phosphate synthase (SPS) family of the Musa acuminata double-haploid Pahang proteome using several
information systems available from the Banana Genome Hub. M. acuminata is a giant herb of the monocotyledon class.

To start with the Banana Genome Hub, go to http://banana-genome.cirad.fr/

1. Search for the Musa SPS Gene Family
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Figure 1: Genes search (Advance Search).

Method

Click on Advanced Search located in the dropdown menu TOOLS of the main menu.

http://banana-genome.cirad.fr/advanced

Gene retrieval can be performed using keywords, Locus, InterPro domains, GO Terms or genome location. Access the search field by clicking desired type of search. The

loci of the resulting genes are located on the karyotypes and listed in a table with their genome location along the chromosome as well as their polypeptide product. To
study the SPS, we searched for the InterPro IPR012819 corresponding to the Sucrose-phosphate synthase domain. By clicking on the name of one of the resulting gene
(e.g. GSMUA_AchrdP06050_001) it leads to the genome browser, GBrowse.
Results
The four genes corresponding to this search are:

*  GSMUA_Achr4P16070_001

*  GSMUA_Achr4P06050_001

*  GSMUA_Achr6P17480_001

*  GSMUA_Achr9pP22510_001

2. Structural Annotation

2.1. Genes

To analyze the structure of these genes, it is possible through the Community Annotation System (CAS) accessible via the dropdown menu TOOLS (http://banana-
genome.cirad.fr/gene_annotation).
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Figure 2: Genome browser (GBrowse).

Method

The Banana Genome Browser is accessible through links in various locations, (i) the most obvious is from the GBROWSE tab on the bar menu of the Banana Genome
Hub, but (ii) it can be accessed by clicking on the name of a gene resulting from the Advanced Search.

(i) Search by name: you go to http://banana-genome.cirad.fr/cgi-bin/gbrowse/musa_acuminata/ then you search for GSMUA_Achr4P06050_001.

(ii) Search by region: you go directly to
http://banana-genome.cirad.fr/cgi-bin/gbrowse/musatract_tripal/?name=chr4:4615503..4623898
The choice of displayed tracks is available on the «Select Tracks» tab. Information about each feature is available via the question mark. By clicking on the tracks you can

display more information and external links.

Looking at GSMUA_Achr4P06050_001 in the genome browser allows checking its intron/exon structure. Indeed, GBrowse provides information about the genomic
region (chr4:4,615,503..4,623,898) and can aggregate various types of data such as similarities with EST, polypeptide sequences. The available information can be
customized by checking/unchecking in track boxes. By clicking on any track feature, a pop up displays more information about the feature and provides external links
such as cross references to other databases.

http://www.ebi.ac.uk/interpro/DisplaylproEntry?ac=1PR012819

http://www.uniprot.org/uniprot/P31927

http://rice.plantbiology.msu.edu/cgi-bin/ORF infopage.cgi?orf=LOC 0s08920660.1

http://www.uniprot.org/uniprot/Q6ZHZ1

In the case of Reference Gene annotation (manual) track, the feature pop up provides a link to several tools of the Banana Genome Hub such as Artemis annotation

editor (Figure 3) and gene reports (GBrowse; Tripal, Figure 5; GreenPhyIDB, Figure 6 and Musacyc, Figure 7).

Results

In this case, we compared the automatic prediction of genes (D'Hont et al. 2012 Gene Models (GAZE v1.0) box of the Reference Combiner prediction (automatic) track)
with the manual gene annotation (CDS box of the Reference Gene annotation (manual) track) and similarities with other genes and proteins (Best Hits, Reciprocal BH).
The annotation comparison will allow to quickly checked whether the structure of the predicted gene (GSMUA_Achr4P06050 001 chr4:4,615,503..4,623,898) is correct.
Structural modifications of size large enough should be visible in the Reference Gene annotation (manual) track. We can see by comparing those tracks, that exon 11 and
12 of GSMUA_Achr4P06050_001 predicted by GAZE were manually merged. These exons were merged for all of the four Musa SPS genes. The visualization of the
GBrowse report shows that the annotation has been made by our team (e.g. owner: sidibebocs).
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Figure 3: Annotation editor (Artemis).

Method

To edit a gene, you need to launch Artemis via the “Edit with Artemis” link in the GBrowse pop up of a banana gene or polypeptide or in the Gene Report (visible in
figure 2).

http://banana-genome.cirad.fr/cgi-bin/artemis.pl?species=musa;name=chr4:4590502..4648898

There is two ways to use the annotation tool: if you have an account, you can participate to the community annotation system by modifying features stored into the

Chado Database. If you do not have an account, you can ask an account (see http://banana-genome.cirad.fr/content/annotation-account-request on the http://banana-

genome.cirad.fr/[gene_annotation accessible in the TOOLS tab of the Banana Genome Hub Web site) or connect to Artemis with a read-only account: banana_read_only

without password and modifications can be saved on your local computer.

Once Artemis is open, you can visualize the area around the gene of interest. By clicking on the Edit tab and then on the “Select Feature on the Editor” part, you can
access the Artemis gene builder. In this builder you can access information such as comments of the curators that annotated this gene. Clicking on the commit button
calls the Chado Controller annotation inspector module. The annotation Inspector validation window will appear. Clicking OK will commit the modifications whereas
clicking the upper right cross will rollback to the original state. The changes are stored into the Chado database. To have more information about how to annotate a gene
structure, see the Protocol for structural gene annotation and the Chado Controller publication.

http://banana-genome.cirad.fr/documentation

http://www.gnpannot.org/biblio

Like in GBrowse, you can have access the cross references for other databases, in the References tab of the gene builder.

Results

As mentioned before, we can see in the Artemis entry edit window that exons 11 and 12 of GSMUA_Achr4G16070_001 were merged.

In the annotator_comment qualifier of the Core tab of the gene builder, another correction is indicated: “one GC / AG intron-exon junction between exons 5 and 6”
(exon five was extended from 14258178 to 14258199). This modification took into account the rare splicing site, GC, whereas the GAZE combiner predicted instead the
classical GT.

2.2. Molecular Markers
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Figure 4: Genetic Map (CMap).

Method

In order to get information about the genetic environment of the genes, we studied the nearest markers of the genes from the pop-up of the marker track on the
GBrowse by clicking on “View marker on genetic map”.

http://banana-genome.cirad.fr/cmap_viewer?ref map set acc=108;ref map_accs=3150;highlight=111183;comparative_maps=1=map_acc=AF_PAHANG LG4
CMAP provides a physical map of the markers, and via an addition of map, links it to the genetic map (“Add a map” link).

A marker in CMap is linked to the Banana GBrowse and TropGeneDB

http://banana-genome.cirad.fr/cgi-bin/gbrowse/musa_acuminata/?name=mMaCIR1745
http://tropgenedb.cirad.fr/tropgene/JSP/link.jsp?module=BANANA&value=mMaCIR1745&tref=marker&cref=name&tabindex=0&onglet=MAPS&numero=10

Results

We can see in this case that GSMUA_Achr4P16070_001 is in a region with a low recombination rate in the vicinity of the centromere. The closest actual marker
mMaCIR1745 (14069511..14071481) is located at 182 kb in 5’ of GSMUA_Achr4G16070_001. The type of this marker is microsatellite, also known as Simple Sequence

Repeats (SSRs). Quantitative trait locus (QTL) information generated on banana could be added when available, providing additional clues on putative function of the

genes.

3. Functional Annotation

Knowing the structure of the genes of the SPS gene Family in Musa, we wanted to learn more about their function.

3.1. Gene Report
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GSMUA_Achr4P06050_001, GSMUA_Achr4P06050_001
(polypeptide) Musa acuminata

Details

Name  GSMUA_Achr4P06050_001
Unique Name  GSMUA_Achr4P06050_001
Internal ID 210783
Length 1060
Type polypeptide
Location  chr4:4615503..4623898

Organism  Musa acuminata (Banana)

Resources

o Details

o Sequence

o Relationships
o References

o Controlled vocabularies
Assignments

o GO Assignments

o InterPro Report 2012-08-10
o TIGRHomologs

o SwissProtHomologs

o TrEMBLHomologs

External Link

o View in Gbrowse

o GreenPhyl Report

o Edit with Artemis

o MusaCyc Report
CoGe Report

uh WN =

1 - Return to gene visualisation on Gbrowse
2 - Link to Gene informations on Greenphyl
3 - Edition of the gene with the Artemis Software

4 - Link to the MusaCyc tool giving information about the pathway the gene are implied in

5 - Link to the CoGe tool
Figure 5: Gene report.
Method

To get detailed information about a banana gene, mRNA or polypeptide, the Gene Report (Tripal) is accessible through the quick search above the bar menu (in the

banner) of the Banana Genome Hub (search for GSMUA_4P06050 _001) and also via the “Gene Report” link in the GBrowse pop up of a gene or polypeptide (Figure 2).

http://banana-genome.cirad.ff GSMUA 4P06050 001
The gene report provides resources about the protein-coding genes:
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* Details : General information : Name, ID, length, type, Location, Organism

* Sequence : Sequence on fasta format

* Relationship : Other features linked in the Banana Genome Hub

* References : cross references to other external databases
* Controlled vocabularies Assignments

* GO Assignment

* InterPro Report : Links to Interpro Domains

* TIGRHomologs : Best Blast hits against MSU (ex-TIGR) Database
* SwissProtHomologs : Best Blast hits against SwissProt Database

¢ TrEMBLHomologs : Best Blast hits against TrTEMBL Database

External links are also provided to lead to several tools giving complementary information about our gene of interest (GBrowse, Figure 2; Greenphyl, Figure 6; Artemis,

Figure 3; MusaCyc, Figure 7, CoGe).
Results
Tableau 1 General functional information about the search results.

Name Length Location InterPro GO
Domains Assignment
GSMUA_Achr4P06050_001 1060 chr4:4615503..4623898 IPRO00368 G0:0009058
IPRO01296 G0:0005985
IPRO06380 G0:0046524
IPR0O12819
GSMUA_Achr4P16070_001 1083 chr4:14253795..14261027 IPRO00368 G0:0009058
IPRO01296 G0:0005985
IPRO06380 G0:0046524
IPR0O12819
GSMUA_Achr9pP22510_001 1062 chr9:27608557..27620605 IPRO01296 G0:0009058
IPRO06380 G0:0005985
IPR0O12819 G0:0046524
GSMUA_Achr6P17480_001 1044 chr6:11756040..11760311 IPRO01296 G0:0009058
IPRO06380 G0:0005985
IPR0O12819 G0:0046524

Three InterPro domains are common to all genes:
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* [PRO01296 : Glycosyl transferase, group 1

* |PRO03680 : Sucrose-phosphate synthase

* |PR012819 : Sucrose phosphate synthase, plant
An additional InterPro domain was found only in GSMUA_Achr4P16070_001 and GSMUA_Achr9P22510_001: IPRO00368 Sucrose synthase.
The GO Assignments were the same for the four genes:

* (G0:0009058 : biosynthetic process

* (G0:0005985 : sucrose metabolic process

* (G0:0046524 : sucrose-phosphate synthase activity
The controlled vocabulary is available on the CV tab of the Artemis Gene Builder. To have more information about how to annotate a polypeptide function, see the
Protocol for functional gene annotation.
http://banana-genome.cirad.fr/documentation

3.2. Gene Families
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Gene Classification Gene Model ” Gene Sequence ” Domain Pattern ‘Ortholog Predictions ” Similar Sequences (BBMH)
[ FASTA | Excel | CSV | XML |
Home Quick search Gene Family lists. Toolbox Documentation Statistics My List Orthology
N N Evolutionary Node
e Sequence id e Species e Distance e Distance e GO
Gene GSMUA_Achr4T06050_001 PDK_30s883591g005 | Phoenix dactyliers oL 3 GO0005285 GO0008058
G0-0046524
PDK_30s713301g003 Phoenix dactylifera 0113 4 GO0005985 GO0009058
Sequence I GSMUA_AchrdT06050_00q %% mrist - 9 = GOD0465,
Species Muss scuminsts 0s08920660.1 Oryzz sativa 0181 5 ﬁmaassimwﬂm i
EO0046524
Alias MNo gene sliss Bradi3g20120.1 Brachypodium distachyon | 0186 s GO0005985 GO-0009058
Length 102833 SODeLEEIL
Sb09g028570.1 Socrghum bicclor 0187 7 GO0005985 GO0009058
Cross-reference(s) GOD046524
@ Display link[s) {1} : GRMZM2G055331 P01 | Ze2 mays 0209 7 i
i Bradilg30520.1 Brachypedium distachyon | 0338 6 GO0005985 600009058
Gene A phosphate synthase 1 GO0046524
Os06g43630.1 Oryzs sative 0351 7 GOA005385 GOD009058
Gene Ontology GOD046524
@ Display term(s} {3] - : GRMZM2G471083 P01 | Zez mays 0357 7 GO0005985 GOD009058
; GO0046524
s e Sb10g025240.1 Scighum bicolor 0.365 7 GO0005985 GOD009058
Filter status Not filtered GO0046524
GRMZM2G043076_P01 | Zea mays 0368 6 GO0005985 GO-0009058
GO0046524
Bradi3g06220.1 Brachypodium distschyon | 037 8 GO0005985 600009058
GO0046524
[ Gene Classification ” Gene Model ” Gene Sequence ” Domain Pattern ” Ortholog Predictions ” Similar Sequences (BBMH) 0s02909170.1 Cryzs sativz 0ie7 E GO:0005985 GO0009058
GO0046524
GRMZIM2G462613_PO1 Zez mays 0352 10 GO-0005985 600009058
GO0046524
BradiSg12860.1 Brachypodium distachyon | 0.352 1
) © Name © Type Sb049005720.1 Sarghum bicalar n3s2 1 600005985 GO0009058
IPRO01296 Glycosyl transferase, group 1 Domain GOD046524
IPRO0G380 Sucrose-phosphate synthase Domain Cre12.9524000.11.1 Chlamydomaonas reinhardtii| 141 10 GO0009058
IPR012819 Sucrose phosphate synthase, plant Family B i Malus d ica 143 5
1PRO00368 Sucrose synthase ‘ T MDP0000203711 Mzlus domestica 158 5
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IPRO01296 IPRO06380 IPRO12810 IPRODD36S Note sort multiple columns simultanacusly by holding down tha shift key and clicking othar column haadars
I Gene Classification || Gene Model H Gene Sequence ” Domain Pattern ” Ortholog Predictions ’I Similar Sequences (BBMH) t
Figure 1: IPR domains for GSMUA_Achr4T06050_001
[ FASTA | Excel | CSV | XML ]
e Best similar sequences e Species o Score e \Er;lue e GO
At5920280.1 Arzbidopsis thalizna 1483 L} | G0-0005985 GO-0009058 GO0046524
0s08920660.2 Dryzs s3tva 1627 [1} G0-0005985 600009058 Gq Sunnose-pheepiie sj,-*tmea::ulzjl
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Figure 6: Sucrose-phosphate synthase family (GreenPhylIDB).

Method

In order to study further the SPS gene family, we clicked on the GreenPhyl gene report accessible from GBrowse or the Gene report trough the “GreenPhyl Report” link.
http://www.greenphyl.org/cgi-bin/sequence.cqi?p=id&seq_textid=GSMUA_Achr4T06050 001

From the GreenPhyl report, we can access to the InterPro Domains and their Location, to BBMH and to orthologs prediction. For more see Figure 9 and Figure 10.

Results
The observation of the BBMH and the Orthologs confirmed the functional annotation of our genes. Indeed, the GO:0046524 sucrose Phosphatase activity is present in all

of them, as well as InterPro IPRO06380 Sucrose-phosphate synthase.

3.3. Metabolic Pathways
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Search Database Musa acuminagta chal

Musa acuminata Enzyme: Sucrose-phosphate s

| Protein Sequence | | Nucleotide Sequence | | Nucleotide Sequence, Ad

Gene: GSMUA_Achr4P06050 001 Accession Number: GSMUA_ACHR4P06050_001

Map Position: [4,615,503 -> 4,623,898] (15.36 centisomes) on Chromosome chr4 ((Genor

Unification Links: Pmid: 16876912 , Tigr:0s01¢69030.2 , Tigr:0s01g69030.3 , Tigr:0s014d
, Tigr:0s02g09170.2 , Tigr:0s06g43630.1 , Tigr:0s08g20660.1 , Tigr:0s08g20660.2
Tremb CBTEVS , Tremb D6REYSE , Trembl Q2ABX9 , Trembl:Q65XU0 , Trembl:Q6U
Trembl:Q8H1Y1 , UniProtKB:004932 , UniProtKB:004933 , UniProtkKB:022060 , UniP]
UniProtKB:P31928 , UniProtKB:P49031 , UniProtKB: Q43845 , UniProtKB: Q43876

Relationship Links: InterPro:IN-FAMILY:IPRO00368 , InterPro:IN-FAMILY:IPRO01296 , Inteq
InterPro:IN-FAMILY:IPRO12819

Gene-Reaction Schematic: Kl

f{-'_\
il )—'GSNUH AchrdP1E070_001
L - - )

Musa acuminata Reaction: 2.4.1.14

Species Comparison

Superdasses: Reactions-Classified-By-Conversion-Type -> Simple-Reactions -> Chemical-Reactions -> EC-Reactions -» 2 -- Transferases -» 2.4 -- Glycosytransferases -» 2.4.1 --
Hexosyltransferases
Reactions-Classified-By-Substrate -> Small-Malecule-Reactions

Enzymes and Genes:

Sucrose-phosphate synthase : GSMUA Achr9PZ2510 001

Sucrose-phosphate synthase : GSMUA Achr6P17480 001

Sucrose-phosphate synthase : GSMUA AchrdP16070 001

Sucrose-phosphate synthase : GSMUA Achrd4P06050 001

In Pathway: sucrose biosynthesis

\/
&\

- 0H P j\,
01-2 qQ ; ( H, 0 ,jH “
e

o ’f/ - \
0 - "‘”” . ’[ j\ % a\? /~/ J (\ T . T ] s
; “
o HO? s o~ /”' ~ 0=P—0—P—0”"¢ ]
HO .3 OH ok 1
D-fructose-E-phosphate OH HO® OH

UDP-D-glucose SiEroes=E=
sucrose-6-phosphate uridine-5'-diphosphate

The reaction direction shown, thatis, A + B <==> C + D versus C + D <==> A + B, is in accordance with the Enzyme Commission system.

Most BioCyc compounds have been protonated to a reference pH value of 7.3, and some reactions have been computationally balanced for hydrogen by adding free protons. Please
see the BioCyc Guide for more information.

Enzyme Commission Primary Name for this Reaction: Sucrose-phosphate synthase

Quick Search | Gene Search

Search Database Musa acumingta change

A ){BSHUA_Achr&P17480_001
|

GSMUA_Achr3P22510_001

GO Terms:

Biological Process: |[GO:0005985 - sucrose metabolic process
G0:0009058 - biosynthetic process

GO:0046524 - sucrose-phosphate synthase activity

MultiFun Terms: UNCLASSIFIED

Enzymatic reaction of: sucrose-phosphate synthase {Su:rnse—ph:lsphate sI

The reaction direction shown, that is, A + B <==
Commission system.

> C + Dversus C + D <==> A + B, is in accf

The reaction is favored in the direction shown.

In Pathways:l SUCrose biosinth esis: )

Home ‘ Search ‘ Tools | Help ‘ Pathway
Musa acuminata Pathway: sucrose biosynthesis F—
Show Predicted Enzymes [+ [ More Detail | [Less Detail| [Species Gomparison |
5.4,2,2
b-D-glucose-6-phosrhat D-glucose 6-phosphate4——— —a-D-glucose 1-phosphat U0P-B-glucos — — sucrose-6-phosphate

D-fructose-B-phosphate uridine-5"-diphosphate
W
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Figure 7: Enzyme Sucrose-phosphate synthase, reaction 2.4.1.14 and pathway sucrose biosynthesis (Pathway Tools / MusaCyc).

Method

MusaCyc displays information about all enzymes implied in the reaction and also in the pathway. It provides biological information about the reaction and the pathway.
In order to get information about the metabolic pathways of the SPS gene family in plants, we clicked on the “MusaCyc Report” link available on GBrowse and the gene
report.

http://banana-genome.cirad.fr/musacyc report?GSMUA Achr4P06050 001

As in other systems, you can have access to cross references to other databases, in the “Unification Links” and the “Relationship Links” paragraphs. If you click on the
Enzyme Commission (EC) number (here 2.1.4.14), you can also have cross references to the BRENDA and ENZYME databases.

http://enzyme.expasy.org/EC/2.4.1.14

By clicking on the Enzymatic reaction, you can have access to the catalyzing step of sucrose biosynthesis from UDP-glucose and fructose- 6-phosphate.
http://gohelle.cirad.fr:1555/MUSA/NEW-IMAGE ?type=REACTION&object=SUCROSE-PHOSPHATE-SYNTHASE-RXN

By clicking on the Pathway, you can have access to the sucrose bioisynthesis pathway.

http://gohelle.cirad.fr:1555/MUSA/NEW-IMAGE ?type=PATHWAY &object=SUCSYN-PWY

Results

The EC number 2.1.4.14 was predicted for GSMUA_Achr4P06050_001. It corresponds to the enzyme named the Sucrose-phosphate synthase catalyzing the last reaction

of the sucrose biosynthesis pathway.
The four SPS polypeptides (GSMUA_Achr4P16070_001, GSMUA_Achr4P06050_001, GSMUA_Achr6P17480_001 and GSMUA_Achr9P22510_001) have an enzymatic
activity characterized by the EC number 2.1.4.14.

3.1. Transcriptome Expression
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Figure 8: EST report (ESTtik).

Method

Evidence of expression is sometimes available with ESTs from ESTtik system. You can go to ESTtik from the “ESTtik reference” link present in the GBrowse pop up of
some EST of the track MusaGenomics consortium ESTs (group E. Similarity with cDNA or EST).

http://esttik.cirad.fr/cgi-

bin/public_quick_search.cgi?name_seq=MUC4R0O1011_B12 .b 093&type=singleton&project=MUC4 ROOTINVITRO&clean=cleaned&navigate=2&species=MusaESTtik
ESTtik report provides information about ESTs such as the sequence, the blast annotation and the database from which is issued the EST.

Results

In this case, the EST MUC4R01011_B12_.b_093 matches with GSMUA_AChr9T22510_001. As described in the detailed report, the EST has been reported on roots, that
confirm the expression of this gene in Musa roots. Moreover the best blastx hit with nr databank is a Musa polypeptide (gb| AAC23914.1 in ESTtik Report) encoded by a
CDS (GenBank:U59489.1) that has a Musa reference by Nascimento,J.R.O. et al. 1997 (PMID:9431676). They said:

“A 952-base pair polymerase-chain-reaction product of sucrose-phosphate synthase (SPS) (EC 2.3.1.14) from banana (Musa acuminata cv. Nanicao) fruit was cloned and
used to study expression of the enzyme during development and ripening. The deduced amino acid sequence shows that banana SPS has a high similarity with the leaf,
tap-root and bean enzymes from other species. Enzyme activity, and mRNA and protein levels point to an increase in SPS expression during ripening. The accumulation
of sucrose was correlated to starch degradation and happened 4 d after SPS mRNA and activity had reached their maxima. These results indicate that access to substrate
and transcriptional activation with increase in SPS expression might be important regulatory events of sweetening during banana fruit ripening. »

These proposals could be confirmed by analysis of recent results on Musa RNA-seq.

http://www.ncbi.nIm.nih.gov/protein/3237273

http://www.ncbi.nlm.nih.gov/nuccore/3237272
http://www.ncbi.nlm.nih.gov/pubmed/9431676

4. Phylogenetic and Paralogous Region Analyses
To explore the evolutionary history of the SPS gene family. We looked at the phylogenetic et paralogous relationship at different scales.

4.1. Phylogenomics System
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Sequence

Species

Annotation

Clustering Level 1

Clustering Level 2

Clustering Level 3

Clustering Level 4

# GSMUA_Achrd4T06050_001 Musa acuminata Sucrose-phosphate synthase 1 | GP000333 GP016032 | GP040672 GP070110
Enter your text to !| | Family Structure Family Composition ” Protein Domains H Protein List ” Phylogenomic Analysis ” Homolog Pred
Home Search Gene Family lists Toolb D . sequence total: 133
2 Number of sequences by species
Family|GP016032
18
Family ID GP016032 20d 1o my list
Family name & f r F h y N bfamily Suggestaname e
Synonym(s) SPS 14
Cross-reference(s) PMID: 16876912
Family Ontology 12
B Hide
10
lecular_function GO (70%) - sucrose-phosphate synthase activity
biological_process GO0:0005985 (70%) - sucrose metabolic process 8
G0:0009058 (B0%) - biosynthetic process
9 4 (wlo splice)
Curation status 4 (wl splice)
o @ .-
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) Podi O Y r»»c,, %as. ti
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Figure 1: Ny of sequence by species in current family. Lower bars indicate count of sequences without splice forms, brighter bars
[ Excel | CSV | XML | FASTA ]
° Sequence ° Species ° s::,': ° UniProt ° InterPro ° Annotation ° g:::l ogy
@ GSMUA_AchrdT16070_001 Musa acuminata e ies Sucrose- oo oea0cs
1PRO06380 phosphate :
IPRO12819 GO:0046524
IPRO0036B synthase
@ GSMUA_Achr6T17480_001 Musa acuminata it i“cm:e; o aosece
phosphate -
IPRO12819 synthase 2 GO:0046524
& GSMUA_AchroT22510_001 Musa acuminata o Sucrose- 00005080
iPRO12819 phosphate GO:0046524
synthase 1
Musa acuminata IPR001296 Sucrose- G0:0005385
@|GSMUA_Achr4To6050_001 | PR30 | ppoennate P
iPR012819 GOD:0046524
iPR000368 synthase 1
Note: sort muttiple columns simultanecusly by holding down the shift key and clicking other column headers.
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Figure 9: Phylogenomics system (GreenphylDB)

Method

We can access to the gene families by clicking the links on gene families available from the GreenPhyl Report previously described (GSMUA_Achr4T06050_001; Figure 6),
http://www.greenphyl.org/cgi-bin/sequence.cqi?p=id&seq textid=GSMUA Achr4T06050 001

or by searching the family name (sucrose-phosphate synthase),

http://www.greenphyl.org/cgi-bin/family.cgi?p=id&family id=16032

or by searching the identifier of the InterPro entry of family type (IPR012819).

http://www.greenphyl.org/cgi-bin/family.cgi?p=id&family id=333

GreenPhyl provides gene clusters at 4 levels of stringency, gene families, Interpro domains, the orthologs prediction and the BBMHs, accessible by clicking on the

respective tabs. Through the clusters links, information is provided about the gene family. You can get the Gene ontologies, the distribution of the families between the
species, the InterPro domains, the list of proteins, the prediction of homologs and a phylogenetic analysis.

Results

The four genes previously found (GSMUA_Achr4T16070_001, GSMUA_Achr4T06050_001, GSMUA_Achr6T17480_001 and GSMUA_Achr9T22510_001) belong to a
cluster curated as Sucrose Phosphate Synthase subfamily (cluster GP016032, second level of clustering), which is a subfamily of the superfamily named Sucrose Synthase
(cluster GPO00333, first level of clustering). In this particular case, the phylogenetic analysis was not available for the sucrose phosphate synthase family, but available at
the upper level.
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Figure 10: Phylogenetic trees (GreenphylDB)

Method

The phylogenetic tree of this family is accessible from the “Phylogenomic Analysis” tab and then the button “View gene tree with APTX".

An alternate visualization is proposed through the button “View gene tree with IntreeGreat”. InTreeGreat is developed in the context of the SouthGreen platform.
The Musa SPS polypeptides were flagged with green squares whereas Arabidopsis polypeptides were flagged with avocat squares.

Results
We noticed in this phylogeny that two of our genes of interest are really close together: it appeared that GSMUA_Achr9G22510_001 and GSMUA_Achr4G06050_001

were the result of a recent duplication.

4.2.Phylogeny Refinement
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Figure 11: Upload data to the workflow manager (Galaxy)

Method

As the SPS genes have been manually annotated, we wanted to study if the phylogeny would be different. We performed a new phylogenetic analysis via an in-house
Galaxy Workflow corresponding to the one implemented in GreenPhyIDB.

http://gohelle.cirad.fr/galaxy/

Data uploading to Galaxy can be made from the Advanced Search tool of the Banana Genome Hub or from the Protein List tab in GreenPhyIDB, after choosing species.

You can also upload our own data through the uploading tool of Galaxy. Once the data uploaded, they will appear in green on the right of the screen. They will be
available with a number that can be used by a Galaxy tool. Even if you are not logged in, you can use the Galaxy tools accessible in the left panel of the screen.
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Figure 12: Editing a workflow (Galaxy)
Method

For users who have an account, the workflows are available on the Workflows tab. For those who do not have one, the workflows will not be available, but the tools are
still accessible. You can apply for a account in the computer center section of the SouthGreen Web site.

http://gohelle.cirad.fr/cluster/compte_galaxy.php

The workflows can be modified in the edit section of the workflow menu accessible by clicking on the arrow next to the workflow's name. The different steps are visible
in the central part of the screen. The parameters can be modified for each step in the Details panel.

Results

The workflow “GreenPhyl Phylogenomic analysis workflow (nucleic)” displayed in this example is accessible in the Shared Data / Published Workflows menu of the
Galaxy web site.

http://gohelle.cirad.fr/galaxy/workflow/list published

The protein version is also avalaible (“GreenPhyl Phylogenomic analysis workflow”).
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Figure 13: Running a workflow (Galaxy)
Method

The workflow is launched from the run section. Choose the entry data and then click on the “run workflow” button. The steps will be shown on the history, in grey while

they are waiting and in yellow while process. The workflow finishes running when all the steps are green. If an error occurs, the steps will be red. You can visualize and

download result files of each step by clicking on it.
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Figure 14: Phylogenetic trees (Galaxy)
Results

MUSAC GSMUA_Achr4T06050_001
MUSAC GSMUA_Achr9T22510_001

MUSAC GSMUA_Achr4aG06050_001

MUSAC GSMUA_Achr9G22510_001

# MUSAC GSMUA_Achr6G17480_001

MUSAC GSMUA_Achr4aG16070_001

For the protein analysis, species considered are Oryza sativa (ORYSA), Sorghum bicolor (SORBI), Arabidopsis thaliana (ARATH) and Musa acuminate (MUSAC). We ran the
phylogeny on fewer species and the phylogeny did not change significantly. The genes GSMUA_Achr9G22510_001 and GSMUA_Achr4G06050_001 were still very close

together.
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For the nucleotide analysis, only Musa was considered. The results are consistent; the duplication between the genes GSMUA_Achr9G22510_001 and
GSMUA_Achr4G06050_001 is very more recent than between the other genes of the family in Musa.

4.3. Synteny of Paralogous Musa Regions
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Figure 15: Dotplot of paralogous Musa regions coloured according to Musa ancestral blocks (PGDD)

Method

We then tried to determine if the high similarity of these genes was due to block duplication in Musa. For that, we used the Plant Genome Duplication Database (PGDD)
system that provides in our case, paralogous regions between Musa chromosomes, coloured according to Musa ancestral blocks. The hypothesis is that these paralogous
regions come from whole genome duplications (WGD).

PGDD, is available from the DotPlot section of the “Tools” tab (“Syntenic Dotplot” link).

http://banana-genome.cirad.fr/dotplot

To examine the synteny, we clicked on the Dotplot button without giving any parameters. You can zoom afterwards on a square of the dot plot to visualize the Dotplot
between two chromosomes by clicking on a square in the global plot or by selecting the “Display chromosome A vs chromosome B” option. The scale then represents the
gene rank. By clicking on a syntenic region, you get the list of co-localized paralogs with the values of Ks and Ka.

Results

We studied the microsynteny between the chromosomes 4 and 9 in order to conclude if the genes GSMUA_Achr9G22510_001 and GSMUA_Achr4G06050_001 that
appeared very similar on the phylogeny (Figure 10 and Figure 14) were issued from the same duplicated ancestral block. We noticed that the genomic regions are issued
from WGD event of the ancestral block 4 (Figure 1), but our two genes are not listed as syntenic in this table. Further studies will be required to confirm whether or not
the duplication between GSMUA_Achr9G22510_001 and GSMUA_Achr4G06050_001 is linked to a WGD event.
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